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HOW TO CONTACT TELEDYNE RD INSTRUMENTS 

If you have technical issues or questions involving a specific application or deployment with your instru-
ment, contact our Field Service group:  

Teledyne RD Instruments  Teledyne RD Instruments Europe 

14020 Stowe Drive 
Poway, California 92064 

 2A Les Nertieres 
5 Avenue Hector Pintus 
06610 La Gaude, France 

Phone +1 (858) 842-2600  Phone +33(0) 492-110-930 

Sales – rdisales@teledyne.com  Sales – rdie@teledyne.com 

Field Service – rdifs@teledyne.com  Field Service – rdiefs@teledyne.com 

Client Services Administration – rdicsadmin@teledyne.com 

Web: https://www.teledynemarine.com  

For all your customer service needs including our emergency 24/7 technical support, call +1 (858) 842-2700 

Self-Service Customer Portal 
Use our online customer portal at https://www.teledynemarine.com/support/RDI/technical-manuals to download manuals or other 
Teledyne RDI documentation.  

Teledyne Marine Software Portal 
Teledyne RD Instruments Firmware, software, and Field Service Bulletins can be accessed only via our Teledyne Marine software portal.  

To register, please go to https://teledynemarine.my.site.com/TMsoftwareportal/s/ to set up your customer support account. After your 
account is approved, you will receive an e-mail with a link to set up your log in credentials to access the portal (this can take up to 24 hours).  

Once you have secured an account, use the Teledyne Marine software portal to access this data with your unique username and password. 

If you have an urgent need, please call our Technical Support hotline at +1-858-842-2700.  
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mailto:rdicsadmin@teledyne.com
https://www.teledynemarine.com/
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Getting Started 

Identifying what’s in the Box 
Ocean Surveyor/Observer Inventory 

Part Number Name Description 
OSII38, OSII75, 
OSII150F, OSII150 
 
71A-2019-01 (38 kHz) 
71A-2019-02 (75 kHz) 
71A-2019-03 (150 kHz) 

Ocean Surveyor/Observer  
 
 
Deckbox/chassis 

The Ocean Surveyor/Observer system includes the transducer, connector dummy 
plug, and electronic chassis. When unpacking, use care to prevent physical damage 
to the transducer face and connectors. 

97A-6004-00 (38 kHz) 
97A-6005-00 (75 kHz) 
97A-6006-00 (150 kHz) 
974-6011-00 (Chassis) 

Shipping Case Shipping case with foam inserts. 

73A-6010-xxx 
73A-6017-xxx 
73A-6024-xxx 
 

I/O Cable 

The Ocean Surveyor/Observer I/O cable allows you to connect the Ocean 
Surveyor/Observer transducer to the electronics chassis and computer. The I/O 
cable is available with straight or right-angle connectors and with both connectors 
installed or only the wet-end connector installed. 

730-6002-00 
730-6003-00 RS-232 cables RS-232 cable 25/25 pin and 9/25 pin. 

95A-6053-00 Ocean Surveyor/Observer 
Getting Started Sheet 

A printed quick start card showing test setup is included. A PDF version is included 
on the documentation CD. 

95Z-6007-00 

Download instructions This sheet has instructions for downloading the software and manuals. 

WinADCP  WinADCP gives users a visual display of the entire set of data. You can zoom in on 
a portion of the data for closer analysis and export data to text or MatLab files.  

TRDI Toolz  Utility software that can be used to test the system. 

VmDas  
VmDas is a real-time data collection software package for use with vessel mounted 
ADCPs. This software package supports the Workhorse PD0 Binary Output Data 
Formats for data collection, playback, and reprocessing. 

75AK6011-00 Tools and spare parts See Table 1 for a list of included parts. 

 

 

This list only shows the part included with the standard Ocean Surveyor/Observer. See the 
packing slip for additional options. If you are missing parts, contact TRDI support 
rdifs@teledyne.com or call +1 (858) 842-2700. 

 

mailto:rdifs@teledyne.com
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Table 1: Ocean Surveyor/Observer Spare Parts  
Item ID Description Where Used 

97Z-6017-00 2-020 O-ring End-Cap/Top Hat connector 

97Z-6019-00 2-022 O-ring I/O Cable wet end connector 

5020 Lubricant, silicone O-ring lubricant 

314025 Fuse, 25A Fast blow, 3AB Power Assembly PCB 

M4x0.7x6PH Screw, pan head, SST Electronic Chassis cover 

 

 

TRDI recommends that the Top Hat/End-Cap and Vent Plug O-rings be replaced whenever the 
transducer assembly is opened. These O-rings are not included in the spare parts kit.  
Make sure you have replacement parts before opening the transducer. 

 

Installing Documentation and Software 
The Ocean Surveyor/Observer documentation and software are downloaded.  

1. Follow the instruction sheet on downloading TRDI software and manuals. 

2. Software is available on https://teledynemarine.my.site.com/TMsoftwareportal/s/. 
Install TRDI Toolz, WinADCP and VmDas. 

3. Use our online customer portal at https://www.teledynemarine.com/support/RDI/technical-manuals 
to download manuals or other Teledyne RDI documentation. Download the Ocean Surveyor In-
stallation Guide and Technical Manual. 

  

Ocean Surveyor/Observer Installation Guide Ocean Surveyor/Observer Installation Technical Manual 

 

https://teledynemarine.my.site.com/TMsoftwareportal/s/
https://www.teledynemarine.com/support/RDI/technical-manuals
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Connecting to the System 

Power Overview 
The Ocean Surveyor/Observer uses 1600 watts of peak power. Teledyne RD Instruments recommends us-
ing a UPS system with a rated output power of at least 2400 watts.  

All Ocean Surveyor/Observer ADCPs draw the same amount of peak current and inrush current (power 
up current draw). They will also draw the same average power assuming that they are setup the same.  

There is no frequency dependence on the power requirement. All Ocean Surveyor/Observer ADCP fre-
quencies (38, 75, and 150) use the same amount of peak power, 1600 Watts. The only difference is the du-
ration that they draw the peak power. 

Here are the power specifications for all Ocean Surveyor/Observer ADCPs: 

Table 2. Ocean Surveyor/Ocean Observer Electronics Chassis Power  
Part number 71A-2019-01  
Part number 71A-2019-02  
Part number 71A-2019-03  

OS38 Deckbox connects ONLY to 38 kHz transducer  
OS75 Deckbox connects ONLY to 75 kHz transducer 
OS150 Deckbox connects ONLY to 150 kHz transducer 

Electronics Chassis Input Voltage 90-120VAC or 220-240VAC, 47-63Hz 

Electronics Chassis Output Voltage 48VDC 50Amps Max 

Input Power (between transmit) 60W Typical 
Input Current @ 230VAC <34Amps rms 

Ride through time 20ms 

Transient Surge EN/IEC 1000-4-2 Level 4 

Common mode & normal mode EN/IEC 1000-4-5 Level 3 

Recommended UPS 3200Watts (2200Watts Minimum) 
 

Table 3. Ocean Surveyor/Ocean Observer Transducer Power Requirements  
ADCP Input Voltage 24-48VDC (48VDC Typical) 

Power 1600W peak 

Inrush Current <46A 

Transmit Power 1100W typical 

Standby Power 2W 

 

 

TRDI recommends a dedicated AC circuit protected by a 20 Amp (115 VAC) or 40 Amp (230 
VAC) circuit breaker. 
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Bench Test 

 

Ocean Surveyor/Observer Connections for Bench Test 

 

The I/O connector on the transducer uses a 2-020 O-ring and the I/O cable (wet end) uses a 
2-022 O-ring. Always check that both O-rings are in place when connecting the I/O cable to 
the transducer. The 2-022 O-ring has a tendency to fall out if the cable connector is dropped. 
If either of these O-rings are missing or damaged, the transducer will flood. 

 

To connect the I/O cable:  

1. Verify the O-ring on the end-cap connector (2-020) and the wet end of the cable (2-022) are both 
installed. 

2. Rotate the cable connector to align the key and pins and then insert it into the receptacle. 

3. Push straight in to fully seat the connector. 

4. Thread the coupling ring onto the receptacle to complete the connection. 
 

 

Make sure the Electronic Chassis/Deckbox frequency matches the transducer frequency.  
Connecting incorrect frequencies to the chassis may damage the transducer. 
71A-2019-01 – OS38 Deckbox connects ONLY to 38 kHz transducer 
71A-2019-02 – OS75 Deckbox connects ONLY to 75 kHz transducer 
71A-2019-03 – OS150 Deckbox connects ONLY to 150 kHz transducer 
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Connecting to the Ocean Surveyor / Observer 
To establish communications with the Ocean Surveyor / Observer:   

1. Connect the system and apply power. 

2. Start the TRDI Toolz software. 

3. Select New Serial Connection. 

4. Enter the ADCP’s communication settings. Select the COM Port the serial cable is connected to 
and set the Baud Rate from the drop-down lists. If you are unsure of the ADCP’s baud rate, use 
Tools, Find ADCP. TRDI Toolz will try different baud rates until it connects to the ADCP. 

5. Click the Connect button. Once connected, the button will change to Disconnect. 

6. Click the Break ( ) button. From the Break button drop down menu, select Hard Break. The 
wakeup banner will display in the terminal window. 

[[BREAK Wakeup A] 
Broadband ADCP Version 23.xx 
Teledyne RD Instruments (c) 2006 
All Rights Reserved. 
> 
 

 
A delay of up to three seconds before the message appears is normal. 

 

Changing the Baud Rate  
The Ocean Surveyor / Observer ADCP can be set to communicate at baud rates from 300 to 115200. The 
factory default baud rate is always 9600 baud. The baud rate is controlled via the CB-command. The fol-
lowing procedure explains how to set the baud rate and save it in the ADCP. This procedure assumes that 
you will be using the program TRDI Toolz that is supplied by Teledyne RD Instruments.  

[BREAK Wakeup A] 
Broadband ADCP Version 23.xx 
Teledyne RD Instruments (c) 2006 
All Rights Reserved. 
>cr1 
[Parameters set to FACTORY defaults] 
> 

Connect the ADCP to the computer and apply power. 

Start the TRDI Toolz program and establish 
communications with the ADCP.  

Click the Break ( ) button. 
At the ">" prompt in the communication window, type 
CR1 then press the Enter key. This will set the ADCP to 
the factory default settings. 

 

BAUD RATE CB-command 
300 CB011 
1200 CB111  
2400 CB211 
4800 CB311 
9600 CB411 (Default) 
19200 CB511 
38400 CB611 
57600 CB711  
115200 CB811 

 

Send the CB-command that selects the baud rate you 
want to use. The table on the left shows the CB-
command settings for different baud rates with no 
parity and 1 stop bit. 

For example, to change the baud rate to 115200, at 
the ">" prompt in the communication window, type 
cb811 then press the Enter key. 

The CB? command will identify the 
communication setting. 

 



P/N 95A-6052-00 (January 2026) Ocean Surveyor / Ocean Observer Deployment Guide 

Page 6 EAR99 Technology Subject to Restrictions Contained on the Cover Page.  
 
 

>cb? 
CB = 411 ----------------- Serial Port Control (Baud 
[4=9600]; Par; Stop) 
>cb811 
>CK 
[Parameters saved as USER defaults] 
>cb? 
CB = 811 ----------------- Serial Port Control (Baud 
[8=115200]; Par; Stop) 
> 

TRDI Toolz will send the command CK to save the new 
baud rate setting. 

Exit TRDI Toolz. 

The ADCP is now set for the new baud rate. The baud 
rate will stay at this setting until you change it back 
with the CB command. 

Exit TRDI Toolz so the communication port is 
available for use with other programs. 

 

Testing the Ocean Surveyor/Observer 
You should test the Ocean Surveyor/Observer:  

• When you first receive the system.  

• Before each deployment or every six months.  

• When you suspect instrument problems.  

• After each deployment.  

 

Do NOT ping the Ocean Surveyor/Observer with the transducer in air. The power assembly 
board will short, causing the electronics chassis to no longer communicate. The transducer is 
pinged by sending a CS or PT5 command or if VmDas is started for collecting data – either of 
these methods will cause damage if the transducer is in air. 

 

[BREAK Wakeup A] 
Broadband ADCP Version 23.xx 
Teledyne RD Instruments (c) 2006 
All Rights Reserved. 
>CR1 
[Parameters set to FACTORY defaults] 
>CK 
[Parameters saved as USER defaults] 
>PA 
RAM test...........PASS 
ROM test...........PASS 
Receive test.......PASS 
Bandwidth test.....PASS 
>PS0 
       Frequency:  38400 HZ 
   Configuration:  4 BEAM, JANUS 
 Transducer Type:  ROUND 36x36 
  Beamformer Rev:  A02 or later 
      Beam Angle:  30 DEGREES 
    Beam Pattern:  CONVEX 
     Orientation:  DOWN 
    CPU Firmware:  23.03  
    FPGA Version:  XA 
 Attitude Sensor:  SYNCHRO 
> 
 

Start the TRDI Toolz program and establish communications 
with the ADCP.  

Click the Break ( ) button. 

At the “>” prompt in the communication window, enter the 
command CR1 then press the Enter key. This will set the Ocean 
Surveyor/Observer to the factory default settings. 

At the “>” prompt in the communication window, enter the 
command CK then press the Enter key. This will save the 
factory default setting as the user default. 

Place the Ocean Surveyor/Observer in a tank of water (at least a 
few inches to cover the transducer face).  

At the “>” prompt in the communication window, enter the 
command PA then press the Enter key. This will run the Ocean 
Surveyor/Observer deployment test. 

At the “>” prompt in the communication window, enter the 
command PS0 then press the Enter key. PS0 displays system 
configuration info. 

If the wakeup displays, PA message displays with a result of 
“PASS”, and PS0 displays, the system is functioning normally. 
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Mechanical Integration  
 

 

Refer to the Ocean Surveyor Installation Guide for full instructions on installing the Ocean 
Surveyor/Observer system. 

 

Quick Review 

  

 Install the electronics chassis  See the Ocean Surveyor Installation Guide, Chapter 1 

 Install the I/O cable  See the Ocean Surveyor Installation Guide, Chapter 1 

 Install the transducer  See the Ocean Surveyor Installation Guide, Chapter 2 

 Install an Acoustic Window  See the Ocean Surveyor Installation Guide, Chapter 3 
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Using VmDas 

 

For detailed information about VmDas, see the VmDas Software User’s Guide. This manual is 
included with the software. 

 

 

Connect the Ocean Surveyor and computer as shown. 

 

 

Start VmDas.  

On the File menu, click Collect Data.  

On the Options menu, click Load. Select the Default.ini 
file and click Open. 
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On the Options menu, click Edit Data Options. Click 
the Communications tab and set the communications 
settings with the ADCP and NMEA ports. 

 

 

Click the ADCP Setup tab. Set the Ensemble Time to 
the value shown in the table below.  

Select the Use File button and choose a default 
command file for your ADCP, and load it into VmDas 
using the Browse button. 

 

Ensemble Time 
Frequency (kHz) with Bottom Track (sec) w/o Bottom Track (sec) 

38 4 2 
75 2 1 

150 1 1 
 

 

Click the Recording tab. Set the deployment name and 
path to where the data files are recorded. 
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Click the Transforms tab and verify the Transform 
Type, Sensor Configuration, Orientation, Heading 
Source, Tilt Source, Beam Angle, and Heading 
Correction are set to your input.  

Click OK. 

 

 

On the Options menu, click Save As. The options may 
be saved to a file for later retrieval 

 

 

Do NOT ping the Ocean Surveyor/Observer with the transducer in air. The power assembly 
board will short, causing the electronics chassis to no longer communicate. The transducer is 
pinged by sending a CS or PT5 command or if VmDas is started for collecting data – either of 
these methods will cause damage if the transducer is in air. 

 

 

Ensure the transducer is submerged in at least one 
meter of water. 

On the Control menu, click Go to begin collecting data. 
The ADCP Communication and NMEA window will 
open and show the commands from the command file 
being sent to the Ocean Surveyor and the Ocean 
Surveyor’s response. 
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Ocean Surveyor Care 
This section contains a list of items you should be aware of every time you handle, use, or deploy your 
Ocean Surveyor. Please refer to this list often.  

General Handling Guidelines 

 

Do NOT ping the Ocean Surveyor with the transducer in air. The power assembly board will 
short, causing the electronics chassis to no longer communicate. The transducer is pinged by 
sending a CS or PT5 command or if VmDas is started for collecting data – either of these 
methods will cause damage if the transducer is in air. 

 

• Never set the transducer on a hard or rough surface. The urethane face may be damaged. 

• Do not expose the transducer to prolonged sunlight. The urethane face may develop cracks. 
Cover the transducer face on the Ocean Surveyor if it will be exposed to sunlight. 

• Do not scratch or damage the O-ring surfaces or grooves. All O-ring grooves and surfaces must 
be inspected for scratches or damages on every re-assembly. Do not risk a deployment with dam-
aged O-ring surfaces. 

• Do not lift or support an Ocean Surveyor by the external I/O cable. The connector or cable will 
break. 

• Use three 0.5-inch eyelet bolts to lift a 38 kHz transducer. See outline installation drawing 96A-
6009 for the bolt hole locations. Outline drawings are in the Installation Guide. 

Assembly Guidelines 
• The I/O connector on the transducer uses a 2-020 O-ring. Make sure this O-ring is in place before 

connecting the cable. 

• The I/O cable (wet end) uses a 2-022 O-ring. Always check that the I/O cable O-ring is in place 
when connecting the I/O cable to the transducer.  

 

The 2-022 O-ring has a tendency to fall out if the cable connector is dropped. If either of 
these O-rings are missing or damaged, the Ocean Surveyor/Observer transducer will flood. 

 

• Read the Ocean Surveyor/Observer Technical Manual for details on Ocean Surveyor re-assem-
bly. Make sure the top hat assembly O-rings stay in their groove when you re-assemble the 
Ocean Surveyor. Tighten the Top Hat hardware as specified. Loose, missing, or stripped Top Hat 
mounting hardware or damaged O-rings can cause the Ocean Surveyor transducer to flood.  

Deployment Guidelines 
• Use the default Command Files (installed to the same directory as VmDas) to help setup the 

Ocean Surveyor/Observer. 

 

The Ocean Surveyor/Observer transducer may be damaged by pressure waves from seismic 
activity. Do not deploy the ADCP where it is subject to significant pressure waves from the 
operation of seismic air guns or similar equipment. 
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Want to know more? 
Congratulations! You have completed the Ocean Surveyor/Observer Deployment Guide. Read the follow-
ing chapters in the Ocean Surveyor/Observer Technical Manual for more detailed information. 

 Chapter 1 –Ocean Surveyor/Observer Overview  
This chapter includes an overview of the Ocean Surveyor/Observer features, options, computer and power require-
ments, and connecting to the Ocean Surveyor/Observer.  

 Chapter 2 – Maintenance  
This chapter covers Ocean Surveyor/Observer maintenance. Use this section to make sure the Ocean Surveyor/Ob-
server is ready for a deployment.   

 Chapter 3 – Testing the Ocean Surveyor/Observer  
This chapter covers test procedures and interpreting the test results.  

 Chapter 4 – Troubleshooting the Ocean Surveyor/Observer  
This chapter covers troubleshooting procedures.  

 Chapter 5 – Returning Systems to TRDI for Service  
Use this information to obtain a Return Material Authorization (RMA) number if the Ocean Surveyor/Observer 
needs to be returned to TRDI. 

 Chapter 6 – Commands  
This chapter defines the commands used by the Ocean Surveyor/Observer.   

 Chapter 7 – Output Data Formats  
This chapter defines the output data formats used by the Ocean Surveyor/Observer.   

 

 Installation Guide  
This guide covers installation of the transducer and electronics chassis and includes specifications and dimensions 
for the Ocean Surveyor/Observer (including outline installation drawings). 

 

 VmDas Software User’s Guide  
This guide covers using VmDas and includes tutorials to help learn about the software. 

 

PDDecoder Library in C language 
The Teledyne Marine PDDecoder library is an open source library written in C language to decode the 
PD0 data formats that are commonly output by Teledyne Marine/Teledyne RD Instruments ADCPs.  

Available for download from the Teledyne Marine software portal: 
https://teledynemarine.my.site.com/TMsoftwareportal/s/ 
 

 

 

 

https://teledynemarine.my.site.com/TMsoftwareportal/s/
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